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Introduction 
 

Overview 

This user guide is to assist applicants with the use of the NJDHTS SAGE application, including technical requirements, 
user assignment, application initiation, and application submission. 

Contact Information 
The SAGE Portal has supplied the following contact information for users:  
 

Agency/Individual Name Phone Number Email Address Website URL 

Agate Software Helpdesk 1 (800) 820-1890 helpdesk@agatesoftware.com  

 

Roles 

The SAGE Portal allows users to be assigned specific roles within the system to complete their tasks. The role of an 
individual can be found on the Home page in the welcome panel. 
 

• The functions a specific user will be able to view or complete depends on the role(s) that a user is assigned.  

• Functions may include (but not limited to) filling in forms (including uploading files), initiating reports, 
and pushing the document from one status to the next status. 

 

• A user may have multiple roles within the system.  

• These roles may be for the same organization, or different organizations. Not all systems allow a user to 
be assigned to multiple organizations. 

• That user will also have multiple logins with separate usernames and passwords for each role.  
 
There are two security roles defined for NJDHTS SAGE users:  
 
Authorized Official 
Agency Administrator 
 
These roles have different security access to work on the applications and reports. Once the Authorized Officials are 
identified and their new user accounts created, the Authorized Officials will select and enter their own organization’s 
staff names to access NJDHTS SAGE. The organization’s staff entered by the Authorized Officials will be assigned to the 
Agency Administrator security level role. Each security role is summarized below: 
 
NOTE: Authorized Officials will be assigning their staff in NJDCA Green SAGE and that information will be applicable to 
NJDHTS SAGE. 
Authorized Officials will be able to: 
• Edit and delete user account information for Agency Administrators (Project Directors and Financial Officers) 
• Enter, update and delete information on applications 
• Download and attach files to the applications 
• Submit applications, for the various applications available to NJDHTS SAGE, with printable access to agreement terms 
and conditions 
• Check on the status of each application 
Agency Administrators (Project Directors and Financial Officers) will be able to: 
• Initiate and submit grant applications, progress reports and reimbursement requests 
• Enter, update and delete information on applications, progress reports and reimbursement requests 
• Download and attach files to applications, progress reports and reimbursement requests 
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• Modify applications, progress reports and reimbursement requests with status of 
Modifications Required 
• Check on the status of applications, progress reports and reimbursement requests 
 
Authorized Official - Usually someone in the Mayor's office for a municipality or Freeholders office for a county. This 
person may also be the President or CEO of the organization. 
 
Agency Administrator - This is the person who is in charge of the grant, usually referred to as the Project Director. This 
person works on the day to day implementation of the grant. This is the individual responsible for programmatic 
reporting. Finance Officers (CFO or Treasurer) are also in this role and are responsible for grant reimbursement requests. 
 
In order to receive continued funding or to enter into new grant agreements, it is important that your contact 
information be as up-to-date as possible. By keeping your user record and organization record current with all of the 
latest changes, NJDHTS SAGE staff will be able to contact you appropriately when the need arises. 
If you are a member of a county or municipality then you must update your contact information in the New Jersey 
Department of Community Affairs (NJDCA) SAGE system. You may access this site here: 
https://dcasage.intelligrants.com/Portal.asp 
 

System Requirements 
 
The system was designed so that most computer users will be able to use it with little or no changes to their computer 
environment. The requirements that are mentioned below are common computer elements that should be already 
present. 
 
 

Internet Connection 

The grants management system is an internet application designed for and accessed via the internet.  
 

Internet Access 

This system was designed to be compatible with common up-to-date web browsers such as Internet Explorer, Firefox, 
Safari, Android, and Chrome. 
 

Adding as a bookmark/favorite menu 
If using Internet Explorer, here instructions on how to bookmark the site. To do so: 

1) Select Favorites → Select Add to Favorites. 
2) This will prompt a menu including the name and URL of the site. 
3) Rename the site (if desired), and click on the Add button. 

 

Adding to the list of Trusted Sites 
If using Internet Explorer, it is recommended that the site home page be added to the list of trusted sites. To do so: 

1) Select Tools →Select Internet Options →Select Security → Select Trusted Sites. 
2) In the “Add this website to the zone:” field, enter the following: 

https://njsage.intelligrants.com/Login.aspx?APPTHEME=NJSAGE 
3) Click Add → Click Close → Click OK. 

 

https://dcasage.intelligrants.com/Portal.asp
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Multiple Browser Windows 
Do not open multiple windows or browser tabs while filling out the document, as this can cause issues with browser 
cookies resulting in either being kicked out of the system or work being lost. 
NOTE: If the user need to have multiple windows open please insure that the user is using a separate browser session 
instead.  
 
If utilizing Internet Explorer, click on File → New Session for each browser session. Other internet browsers will require 
third party add-ons to manage multiple browser sessions. 
 

Adobe Acrobat DC 

Adobe Acrobat DC (Adobe Acrobat Reader) is used to view PDF (Portable Document Format) documents. The system will 
automatically generate grant documents in PDF format using information that has been saved into the various narrative 
and budget pages. Using Adobe Acrobat DC, the user may choose to view, print, or save these documents. Users who do 
not have this software installed on their systems will need to download it from www.adobe.com. 
  

http://www.adobe.com/
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System Login Page 
 

URL 
To access SAGE Portal, type the following into the address bar of the web browser and press Enter.  
https://njsage.intelligrants.com/Login.aspx?APPTHEME=NJSAGE  
 
NOTE: SAGE Portal does not save the username and password. This option may be available for some browsers. 
 

 
Figure 1 The Login Page 

 

“Locked Out” 
• Once a user has exceeded the number of login attempts for the portal, they are “locked out” for 15 minutes. 

That means that they need to wait 15 minutes before attempting to re-login to the system.  

• The user may also use the Forgot Password link to request a temporary password at any point. Instructions for 
the “Forgot Password” link are provided below. 

 

Forgot Password 
SAGE Portal allows the user to request a temporary password be generated and sent to their email address. To do so, 
complete the following steps: 

1) Click on the Forgot Password? link. 

https://njsage.intelligrants.com/Login.aspx?APPTHEME=NJSAGE
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2) Enter the username and the email address. Click on the RESET MY PASSWORD AND E-MAIL ME THE NEW ONE 
button. A temporary password will be sent to the email address supplied. 
 

 
 
3) Once the user has received a temporary password, they will need to login.  

NOTE: The password field is case sensitive and will not recognize characters of the wrong case. Precision when 
entering the username into the username field will decrease the risk of error messages being generated by 
the system. 
 

4) At that point, the user will be brought directly to the Profile Link and requested to create a new password. They 
will need to generate a new password and enter it into the Password and Confirm Password fields in the middle 
of the page, then click on the Save button. 

 
 

New User 
SAGE Portal allows the user to request access to the system. To do so, complete the following steps: 

1) Click on the New User link. 
2) Fill in the required fields (*) and any optional fields desired, and click on the Save button. 
3) NOTE: Users registering by the New User link will need to be approved prior to being allowed to access the 

site. Users registering for SAGE Portal need to be approved by your Agency Authorized Official or an HTS 
Regional Supervisor. 
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4) If a user attempts to access the system before they have been approved, the following message will display: 
 

 
 

NOTE: Users are not able to access documents created prior to the date that they are added to the 
organization. Please follow the instructions found in the Add/Edit people section of the Access Management 
Tools area to add the user to specific document(s). 
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Home 
 
The Home page is the home page for SAGE Portal users. From here, the rest of the system can be navigated.  
 

 
 

Tabs 

Home 
This is a navigation link that will return the user to the Home page from anywhere in the system. 
 

Documents 
This is a navigation link that will allow the user to access documents available to that organization. The user can access 
this link from anywhere in the system.  
 

Links 

NOTE: Access to specific links is dependent on the role of the user. 
 

Reports 
This is a navigation link that will direct the user to the Reports menu. It contains various reports available to that 
organization and is used to view/export system information in various formats.  
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Training Materials –  
This is a navigation link that will direct the user to the Training Materials menu. It contains various training documents 
that can be utilized to learn the Highway Traffic Safety system. 
 
 

Organization 
This is a navigation link that will direct the user to the Organization page to complete the following functions:  

1) Updating organization specific information. 
2) View / Access Organization Documents. Organization documents will display a list of initiated documents, 

initiated progress reports, and initiated reimbursement requests for the user’s organization.  
 

Profile 
This is a navigation link that will direct the user to their user profile. This page can be utilized to update profile 
information and to change the password. 
 

Logout 
This is a navigation link that will log the user out of the system, and directs the user to a logout confirmation page. 
 

Additional Features 

Welcome Panel 
The Welcome Panel will display the user’s chosen picture, a welcome greeting which includes the user’s first name, and 
the user’s current system role assigned to that login.  
NOTE: Users may also utilize the Change Picture link to choose a different picture than the one that currently displays 
in the Welcome Panel. 
 

Instructions 
As like many locations within the system, this page has an Instructions section offering additional information on 
completing specific tasks. 
 

Home Page Sections 

Initiating an Application/Using the View Available Opportunities 
The View Available Opportunities section is where all the grant proposals available for the organization to apply for are 
found.  

1) Click the View Opportunities button to see what is available to the organization.  
 



 New Jersey, Division of Highway Traffic Safety - Applicant Manual Version 2  
 

2/3/22 Copyright © Agate Software, Inc.  Page 12 of 39 

 

 
 

2) Click on the Filter button to generate a list of search results. 
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3) Users can click on the Apply Now button to start a document. Users can click on the Not Interested button to 
hide an opportunity from view.  

 

 
 

4) Once a opportunity has been started, it can be accessed using either the My Tasks section of the Home page, or 
the Tab Section tab at the top of the screen. 
 

 
 

My Inbox 
The My Inbox section of the home page is where all the notifications sent to the user are found. From here, the 
messages can be read, or messages can be composed. At first glance, the My Inbox section will display the number of 
new messages that are currently in the user’s inbox.  
 

 
 
To expand the Inbox section, click the Open My Inbox button. For further system functionality, navigate to the System 
Messages page by clicking the View All System Messages link. 
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My Tasks  
The My Tasks section of the Home page is where find the task(s) / actions that require the user’s attention are found. 
Links within the tasks are a shortcut to other locations within the system.  At first glance, the My Tasks section will 
display the number of new task(s), additional information about the task(s), and the number of task(s) that are critical.  

1) To expand the My Tasks section, click the Open My Tasks button. 
 

 
 

2) To find out more information about the task, hover over the icon in the Info column of the task.  
NOTE: The user can click on the person with a paper icon to navigate to a Task Check List page with a 
breakdown of subtask(s) required to complete the Task. 
 

 
 

3) To continue working on a task, click on the link found in the Name column of the task. 

 

Application/Grant Search 
 

Application/Grant Search 
 
Application/Grant Search 

1) Click on the Application/Grant Search tab. 
2) Add any search filters (optional) and click the Search button. If no search results are generated, follow the User 

Unable to View Document instructions below. 
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3) To access the document, click on the Document Name link listed in the Name column. 
NOTE: Hovering over a specific link may bring up a textbox containing additional information. 
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User Unable to View Document 
1) If the user is expecting to see a specific document but is unable to view it, please click on the Clear button to 

clear the search results filters prior to clicking the Search button again. 
2) If the user has completed step 1, but is still not able to view the document, it may be that the user needs to be 

logged in with the correct role. Please see the Roles section to confirm that the user has the correct role to 
complete the task.  
NOTE: The user may need to reach out to other members of the organization and/or other agencies to be 
assigned the correct role. 

3) If the user has completed steps 1 and 2, but is still not able to view the document, it may be that the user needs 
to be added to the document. They will need to contact HTS Regional Supervisor of their organization to be added 
to the document. 

 
 

 

Document Menu 

The Document Menu page is the main page for all documents in the system. From here, the user can navigate to all the 
tasks and tools needed. 

1) Navigate to a specific document following the instructions listed in the Application/Grant Search section. 
2) This will bring up additional options shown in the screenshot below. 
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Document Information 
This provides a link that will return the user to the current screen, from anywhere within the document. 
 
Details 
This is an expandable section that, once expanded, will display current information about the user and the document, 
such as the document type, the user organization, the current user role, the status, and the fiscal year. 
 

Menu 
This is the default screen for the item. Clicking on this link will return the user to the default screen. 
 

Forms Menu 
From the Document Menu page, hover over or click on the Forms Menu link. This will direct the user to the Forms 
Menu.  
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Forms Menu Information 
Status Icons 
This will display a different icon based on the status of the form.  
 

Icon Description 

 Blank Page The page has not been started yet. 

  
Page with Pencil The page has been started and saved. 

     Multiple Pages 2 Pages have been started and saved of the same form. 

     Review This page has a review panel attached to it. 

     
Global Error(s) The page has been started and was saved with page errors. 

 
Adobe Page PDF link 

 
Internet Explorer URL link 

 
Page Name 
This is a link that will display the name of the form / link / PDF Download. Click on this link to be directed towards the 
task, action, or data collection form. 
 
Note 
This will display an Icon that indicates that a user has left a note on the form.  
 

Icon Description 

 Notepad A note has been added to the form. 

 
Created By 

• For single page items - this field will list the person who first saved the page, along with a date and time stamp. 

• For multiple page items, PDFs, and URLs - this field will be left blank. 
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Saved By 
• For single page items - this field will list the person who most recently saved the page, along with a date and 

time stamp. 

• For multiple page items, PDFs, and URLs - this field will be left blank. 
 

Sections 
Forms are organized into sections with a section header at the top of the section.  
 

 
 

Successfully Completing a Form 
After navigating to a data collection form, complete the form. The user may do this by entering all the data on the form, 
and clicking the Save button. Then the form will either display the Page Information notification indicating a successful 
save, or a Page Error(s) notification. Continue entering data and saving the page until the user receives the Page 
Information notification and has completed the form. 
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Automatically Populated Fields 
On some forms, calculations are automatically completed, and information is copied over from other forms. 

 
 

 
Repeatable Rows (with SAVE function) 
In some locations, rows will continue to repeat, allowing the user to enter in additional information as needed.  

1) Fill in the available row(s) and click the Save button. 
2) After the page has been saved, additional rows will become available. This process can be repeated by filling in 

the available rows, and clicking the Save button. 
 

 
 
Repeatable Rows (Button) 
In some locations, rows will continue to repeat, allowing the user to enter in additional information as needed.  

1) Fill in the available row(s) and click the Plus Sign icon next to the header to add a row. 
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Situational Business Rules 
In some locations, a field may or may not be required based on other information typed into the document. For 
example, there may be a “Yes/No” question, and if “Yes” is answered, the form may require that the user provide 
information explaining the answer. Be sure to follow the instruction provided both in the instructions on the form and in 
the “Page Error” messages associated with that question.  
 
Uploads & Attachments 
Upload fields can be utilized to upload / attach files to forms, where available. To utilize this field, click the Browse… 
button, and select the desired file that the user wishes to upload, and then click Open. This will bring the file name into 
the field. 
 

 
 

• Only files of the following types are allowed: doc, eps, pdf, jpg, gif, bmp, txt, avi, wmv, ppt, xlsx, mov, dpi, png, 
and mp3. 
NOTE: Some uploads have maximum file sizes. If the user receives an unusual error message, the user can re-
save the file in a smaller size and re-upload the file. 
 

• When combined with Repeatable Rows, the user may have the ability to upload additional attachments. They 
can do this by selecting files for each available upload field, and then clicking the Save button. After saving the 
page, additional upload fields will become available. 
 

Copy & Paste Disclosure 
• Users should be cautious while utilizing the copy and paste function of most word processing programs to 

transfer text into narrative boxes within, as it will not recognize certain formatting, including tables, graphs, 
photographs, bullets, and certain tabs.  

• Users must also be aware of the character limits of each text box, as attempting to copy and paste text that is 
larger than the allotted amount of space will yield an error. The character limit may be found at the bottom left 
of each text box.  

• Users may want to first copy and paste text into any standard “notepad” (or equivalent) program. 
 

Adding and Editing Notes 
To encourage communication within the system, users will have the ability to add notes to a form. Follow these steps: 

1) Click the Add Note button that is located at the top right corner of the page. This will open the Notes panel. This 
panel can be moved to any location on the screen. 

2) To add a new note, click on the Add a New Note button. This will open the Add New Note panel. 
 

 
 

3) Enter a “Subject” and a “Message”, and then check the box next to the name of the users who can view this 
note. The user may also check the All / None checkbox to either check everyone, or no one. 

• View notes by clicking on the link provided in the Messages column. 

• Edit notes by clicking on the link provided in the Action column. 
 

4) Click on the Save button. 
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Printing the Form 
Some data collection forms my offer a PDF version of the data typed into the form. The user can utilize these PDF 
versions to print the form, or to save for future reference. To download a PDF version of the form, click the Print Version 
button that is located at the top right corner of the page. 
 

 
 
Save and Submit [Some Sites have this set up] 
SAGE Portal allows the user to submit the document at the same time a form is being saved. To complete both actions at 
the same time, click on the Save & Submit button on a specific form.  
 

 
 

 
Save/Next [Some Sites have this set up] 
SAGE Portal allows the user to save the form and move to the next form at the same time. To do so, click on the 
Save/Next button. NOTE: The Next button is also available for users to move on to the next form without saving their 
current form. 

 

 
 

Page Save Warning 
If any of the field(s) in a form are changed, a pop-up box will appear if the user attempts to leave the page without 
saving the form first. 

• Click “Ok” to leave the page without saving. 

• Click “Cancel” to return to the form and save changes. 
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Status Changes 
The Status Changes menu is used to push the document through the process steps in the process flow. For example, this 
is how a document can be submitted for review, or returned for revisions/updates or signatures. This menu may have 
just one (1) option, multiple options, or no options listed.  
NOTE: If no options are listed, the user does not have the permissions necessary to move the document out of its 
status. 
 

 
 

1) From the Document Menu page, hover over or click on the Status Change link and then click on the desired 
status of the document.  

2) To change the status of the document, click the Apply Status button located underneath the status the user 
wishes to apply to this document. 

 

Access Management Tools 
From the Document Menu page, hover over or click on the Management Tools link and then click on the desired tool. 
Below a Management Tools Summary has been created, along with sections on various tools. 

 
Management Tools Summary  
Below is a screenshot showing some of the common tools available for updating documents within the system. 
NOTE: Access to these tools is dependent on the user role. 
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Add/Edit Organizations 

Adding Organization(s) 
1) From the Management Tools page, click on the Add/Edit Organizations link. The default page that appears will 

list the organizations already assigned to this document. 
2) In the Organization Search field, enter part of an organization name and click on the Search button. This will 

bring up the Organization(s) Found section. 
 

 
 

3) To add an organization, click on the check box next to the organization name and click on the Save button. 
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Removing Organization(s) 
1) To remove an organization, use the Organization Search tool to locate the organization, click the checkbox next 

to the organization name to deselect that organization. 
2) Click on the Save button. 

 
Add/Edit People 

Adding User(s) 
This tool will allow the user to add new users and existing users to this document.  

1) From the Management Tools page, click on the Add/Edit People management link.  
2) In the Person Search section, enter the user’s name, and then click the Search button. This will bring up the 

People Found section. 

 
 

 
3) To add a person, click on the check box next to their name, select their role, and click the Save button. This will 

grant that user access to the document. 
 

 
 

Removing User(s) 
To revoke user access, within the Current People Assigned section enter an end date in the Active Dates column for that 
user, and then click the Save button. 
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Create Full Print Version  
This tool creates a printable version of the document for reading and/or saving. 
 
Create Full Blank Print Version 
This tool creates a form/template version of the blank document. 
 
Check for Global Errors 
This tool is used to check for Global errors within the document prior to submitting it to the next status. 
 

 
 
View Modification History 
This tool is used to view various modifications that people have made to specific pages in the document. 
 
Date Modification 
This tool will allow the user to modify the dates associated with this document, such as the period dates and the due 
date. To do so, enter the dates the user wishes to apply to this document and click the Save button. 
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Progress Reports and Related Documents 
From the Document Menu page, hover over the Related Documents and Messages link. This will show the Related 
Items page.  
 

 
 

Related Documents 
In the Related Documents section, the user can initiate/view subdocuments, progress reports, reimbursement requests 
or invoices (if available). 
 

 

Initiating a Report 
To initiate a report, please complete the following steps: 

1) Click on the “Initiate a/an” link of a specific report. 
2) Click on the I Agree button for the certification form (if available).  
3) This will bring up the Document Menu for the report that follows the same One-click navigation pattern as 

described in the Document Menu section. The user will be required to complete forms and submit the 
report. 

 

Updating a Report 
To update a report, please complete these steps: 

1) Click on the document link in the Name column for a specific report. 
2) This will bring up the Document Menu for the report that follows the same One-click navigation pattern as 

described in the Document Menu section. The user will be required to complete forms and submit the 
report. 

 

Additional Filters 
• Reports can be sorted by those options listed in the drop-down menu. To use those options, click on one of 

them and click on the Go button (not shown in screenshot). 

• Alternatively, text can be typed into the Filter by Document Type text box and the Go button clicked. 
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Additional Filters 
• Messages can be sorted by those options listed in the drop-down menu. To use those options, click on one of 

them and click on the Go button. 

• The “Show All Messages” checkbox can be clicked as well to display all messages available. 
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My Reports 
 
These reports are used to generate reports designed for exports from the system. 
NOTE: Access to these reports is dependent on the user role. 
 

1) Clicking on a specific report link opens that report on screen.  
2) Enter any search results parameters in the top section of the report.  

 

 
 

3) Click on drop-down menu options to specify how the user wants to view the report. 
 

 
 

4) Click on the Execute button to run the report. Click the Clear button to clear out the search results parameters 
entered in Step 2. 
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5) This will generate the report in the format that the user set up in Step #3. 
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My Training Materials 
 
To access the training materials available to the user, please follow these steps: 

1) Click on the Training Materials. This will bring up a list of manuals and other items. 
 

 
 

2) Click on the link of the manual or other item. 
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Organization(s) 
 

Overview 

The organization(s) link will direct the user to a menu where organization updates can be recorded. These organization 
updates are divided among, but not limited to different sections. 

• Organization Information 

• Organization Members 

• Organization Documents 
 

Organization Information 

 
 

Organization Members 

This section allows the user to manage access by other members. 
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The page includes a list of current (active) members. The function for deactivating/removing organization members is 
also available on this page. 
 

Deactivating/Removing Organization Members 
To deactivate the user from the organization, please follow these instructions: 
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1) Click on the Organization(s) link. 
2) Locate the specific user that is being removed. 
3) Click in the 2nd date field in the Inactive Dates column. This will bring up an auto prompt to select a date for the 

user to be deactivated. 
4) Click on the Save button at the top of the page. 

 

Adding Pre-Existing Members to an Organization 
To add users to an organization by a pre-existing member of the organization, please follow these instructions: 

1) Click on the Organization(s) link. 
2) Click on the Add Members link. 

 
 

 
3) Click on the Add Members link. This will bring up a Person Search field. 
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4) Populate information in the Person Search field and click on the Search button. 
5) Click the checkbox next to that person, select a role from the drop-down menu, and click on the Save button. 
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Adding New Members to an Organization 
To add users to an organization by a pre-existing member of the organization, please follow these instructions: 
NOTE: This is an additional way of registering users. Individuals can register themselves by following the instructions 
in the New User section on the System Login Page. 
 

1) Click on the Organization(s) link. 
2) Click on the Add Members link. 
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3) Click on the New Member button. This will bring up a form requesting basic contact information for that user. 
Complete the form by filling in the required fields (*) and click on the Save & Add to Organization button. 

• For some organizations, the new user receives a username and temporary password by email.  

• For other organizations, the user adding the new member(s) will need to contact those new members 
directly to let them know the usernames and passwords assigned to them. The new members can then 
login and reset their passwords. 
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My Profile 
 
On the profile page, a user can update their contact information and password information. 
 

Contact Information 
1) Navigate to the Profile page. 
2) Update any fields that are not greyed out (Optional – no updates may need to be completed). 
3) When updating the password, create a new password and enter it into both the Password and Confirm 

Password fields towards the bottom of the page.  
NOTE: A password requires both uppercase and lowercase letters and numbers. 

4) Click on the Save button. 
 

 
 

Organization Information 
• Clicking on the Organization link will return the user to the Organization Information section. 

• The Role assigned to the user is listed. 
 

Change my Home Page Picture 
• Allows the user to upload an image to use on their home page. 


